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L I C E N S E  A G R E E M E N T  

 

M L  P O S T E R  F O R  W I N D O W S ®  L I C E N S E  A G R E E M E N T  
 
THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU, THE LICENSEE, 
AND GRANDWELL INDUSTRIES, INC. (“GRANDWELL”). BY USING THIS 
PROGRAM YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, 
PROMPTLY RETURN THE DISK PACKAGE AND OTHER ITEMS THAT ARE A 
PART OF THE PRODUCT IN THEIR ORIGINAL PACKAGE, WITH YOUR PAYMENT 
RECEIPT (“THE RECEIPT”), TO YOUR POINT OF PURCHASE FOR A FULL 
REFUND. 

In consideration of payment of the License Fee, which is a part of the price evidenced by the 
Receipt, GRANDWELL grants to the Licensee a nonexclusive right, without right to sublicense, 
to use this copy of GRANDWELL software, on a single computer at a time. GRANDWELL 
reserves all rights not expressly granted, and retains title and ownership of the software, including 
any subsequent copies in any media. This software and the accompanying written materials are 
copyrighted. You may copy the software solely for backup purposes; all other copying of the 
software or the written materials is expressly forbidden. 

As the only warranty under this Agreement, and in the absence of accident, abuse or 
misapplication, GRANDWELL warrants, to the original Licensee only, that the disk(s) on which 
the software is recorded is free from defects in materials and workmanship under normal use and 
service for a period of ninety (90) days from the date of payment as evidenced by the copy of the 
receipt. GRANDWELL’s only obligation under this agreement is, at GRANDWELL’s option, to 
either (a) return payment as evidenced by a copy of the receipt or (b) replace the disk that does 
not meet GRANDWELL’s limited warranty and which is returned to GRANDWELL with a 
copy of the receipt. THIS WARRANTY GIVES YOU SPECIFIC, LIMITED LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO 
STATE. 

THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING 
THE OWNER’S MANUAL) ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY 
KIND INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, EVEN IF GRANDWELL HAS BEEN 
ADVISED OF THE PURPOSE. GRANDWELL SPECIFICALLY DOES NOT WARRANT 
THAT THE OPERATION OF THE SOFTWARE WILL BE LIABLE FOR ANY DIRECT, 
INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES A RISING OUT OF 
THE USE OF OR INABILITY TO USE SUCH PRODUCT EVEN IF GRANDWELL HAS 
BEEN ADVISED OF THAT POSSIBILITY OF SUCH DAMAGES. SOME STATES DO 
NOT ALLOW THE EXCLUSION OF LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION 
MAY NOT APPLY. 

 
GRANDWELL INDUSTRIES, INC. 

121 Quantum St. • Holly Springs, NC 27540 
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S U P P O R T  P R O G R A M S  

Grandwell Industries Support 
Programs 

B A S I C  S U P P O R T  
As a purchaser of LED message displays, you are automatically entitled to software support from 
Grandwell Industries. Receiving the basic service is easy; just register your software with us by 
filling out and returning the registration form. You must include the registration number of your 
copy of the software on the registration card. The registration number is on the label of your 
distribution disk. 

 

E X T E N D E D  W A R R A N T Y  S U P P O R T  
You are entitled to purchase, from Grandwell Industries, an extended warranty for your display. 
The extended warranty must be purchased prior to the expiration of the original limited warranty. 
Contact a Grandwell sales representative at 800-338-6554 for further details. 
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ML Poster for Windows 1

Chapter  

1 
Introduction 

 Welcome to ML Poster for Windows 
ML Poster for Windows is a comprehensive software program designed exclusively for 
Grandwell Industries’ 700 Series message display boards. Unlike other software programs for 
LED displays, you are not required to purchase additional software. You receive everything 
needed to put your message on your display. 

 
You don’t have to be a computer expert to use 

your message display board! 
 

 ML Poster software features 
ML Poster has a wide variety of features that give you the ability to create informative, eye-
catching messages on your display.  The following are some of the important ones: 

Page Editing Area 
ML Poster allows you to view each line of your page on your computer screen as you write 
the line.  

� Multiple display modes 

ML Poster gives you over 15 different modes for displaying each page; moving in from 
right or left, bottom or top. 

� Variable display speeds 

You can display each page at 10 different speeds. 

� Multiple clear modes 

ML Poster gives you 15 different modes for clearing each page; moving off from right or 
left, bottom or top, or not clearing at all. 

� Date/day/time display 
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ML Poster has a built-in date/day/time function. 

� Scheduling of messages 

Very easy to schedule messages to show at any time of the day for any given time period. 

� Standard Windows features 

You can access the menus in multiple ways—by clicking the menu name with the mouse 
or by pressing the Alt key and the underlined character shown in the menu. Inside the 
menu, you can click an option with the mouse or press the underlined character to 
perform the function—most functions have “keyboard equivalents” so you don’t have to 
stop typing. 

 ML Poster manual features 
We’ve added new features to the manual to make using ML Poster even easier. Here’s a short 
introduction to what’s in the manual. 

� Chapter 2: Software installation 

Here we tell you what you get with the software and how to get up and running. 

� Chapter 3: The Tutorial 

Chapter 3 walks you through the creation of a message program.  

� Chapter 4: Program Construction  

In this chapter, we get down to details of how to make the display board do what you 
want it to do. In the first part of this chapter, we show you each of the parts of the 
Message Editor screen and explain them. Next, we list the commands, organized by type, 
with explanations, steps and parameters to use for each one. 

� Help sections 

Throughout the manual we give you special help sections that are highlighted with icons. 

 

� Hot! 

The Hot! items contain information that is very important and may save you from 
disaster. They are marked by the exclamation points. Here’s an example: 

 

If you accidentally save over an existing file, you can recover it. ML Poster 
creates a backup copy of every message file you save. The backup has the same 
name as the original file with .BAK extension instead of .MSL extension. To 
retrieve the old file, single-click on File in the Menu bar and choose Open. 
Using the drop down menu in the list of File Types, select (*.BAK). Choose 
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the .BAK file of the accidentally saved file. Single-click on the OK button. 

 
� Note 

The Notes contain information that is useful and helpful. You’ll know them by the 
pushpins. Here’s an example: 

  

 

When you use ML Poster for the first time the display message name will be  
“untitled.” 

 

ML Poster for Windows 3





C H A P T E R  2 :  S O F T W A R E  I N S T A L L A T I O N  

ML Poster for Windows 5

Chapter 

2 
Software Installation 

 Computer hardware requirements 
ML Poster operates on a standard IBM or compatible personal computer equipped with a 
hard disk. The following are the minimum requirements: 

� An IBM or 100% compatible personal computer with Windows 95 or higher 

� A CD-ROM drive 

� An RS232 serial port to connect the message display board 

 Registering ML Poster  
To register your copy of ML Poster, complete the registration form in the front of this 
manual and return it to Grandwell Industries, Inc. at the address on the bottom of the 
form, or fax it to 919.552.9830.  When you register your copy of ML Poster, Grandwell 
Industries, Inc. will give you the following additional benefits: 

� Unlimited software and hardware technical support for the life of your 
display (begins when we receive your registration) 

� Information on how to contact Grandwell Industries’ technical support staff 

� Notification of updates to ML Poster  

� Notification of new products  

 Installing the software 
Before you can start to work with ML Poster you must install it on your computer’s hard 
disk. We provide a SETUP program to help you. The SETUP program allows you to 
select the drive and directory where you want to install the software. The SETUP 
program creates the directory and copies all the ML Poster files to your hard disk. 
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After installing the ML Poster, keep the CD-ROM in a safe place for future use.  If you 
ever need to install the software onto a different computer you will need the original 
setup CD.  Just by copying files from the old system to the new one will not work. 

 
Starting the SETUP program 

Use the steps below to start the SETUP program: 

1. Insert the ML Poster CD-ROM in your CD-ROM drive. The Windows should 
detect the CD and starts up the setup program automatically.  Follow the instructions 
on the screen to complete the installation.  If the setup did not start automatically, use 
the following steps to start. 

2. Single-click the Start button at the lower left of the Windows 95 task bar. 

3. Select Run. 

4. Type D:\ SETUP.EXE (Assuming D-drive is your CD-ROM drive) 

5. Press enter or single-click on OK. Follow the instructions to insert additional disks if 
necessary. 

When it’s done, the SETUP program will display a dialogue box indicating that the software 
has been installed successfully and has added the ML Poster software to the Program 
Manager. 

At this point, you can either single-click the ”Launch the software” box then single-click the 
OK button to end the installation and automatically open the software, OR single-click OK 
to end installation without launching the software. 

If you use the default installation locations and need to open the software at a later date, it will 
appear on your computer’s hard drive in the location: C:\Program Files\ML Poster. 

Grandwell Industries, Inc. 6



C H A P T E R  3 :  T H E  T U T O R I A L  

ML Poster for Windows 7

Chapter 

3 
The Tutorial 
In this chapter, we show you how to make a simple file of pages and save them.  After that you 
can move on to Chapter 4: Program Construction to learn more details on creating more involved 
messages. 

For more information on the following details please note the chapters and sections listed in Italic 
parentheses at the end or each step.  

 Creating a message program 
Starting ML Poster 
 

If you haven’t already started ML Poster, do the following: 

1. Single-click Start on your Windows’ task bar and select Program and ML 
Poster.  

Opening a new file 
 

1. If the default display size is not correct, single-click on the New icon in the Tool bar.  
ML Poster will display the New File dialogue box.    (Chapter 4, The File Menu, New) 

2. Select the columns and rows, then single-click OK. 

Adding a line 
 

1. Single-click anywhere on line 2 of the Page Editing Area. 

2. Type “Hello”. 

3. Single-click on the Edit menu and single-click on Center Justify.   (Chapter 4, The Edit 
Menu, Center Justify) 

Adding color to text 
 

1. Single-click on the Edit Menu and single-click on Color.   (ML Poster displays a Color 
dialogue box.)  



C H A P T E R  3 :  T H E  T U T O R I A L  

2. Select the “H” in Hello. 

3.  In the Color dialogue box, single-click on green in the top row of colors.  

4. Select the “o” in Hello. 

5. In the Color dialogue box, single-click on green in the top row of colors.  

6. Select “ell” in Hello. 

7. In the Color dialogue box, single-click on yellow in the top row of colors and single-
click on red in the bottom row of colors. 

8. Single-click on the next line in the Page Editing Area. 

9. Type “World”. ML Poster continues to center the text.  

10. Select “World”. 

11. Single-click Flash in the Color dialogue box. Notice the text, “World”, now appears 
bold but will not simulate flashing. When this message is downloaded to your display, 
“World” will flash. 

Showing the page 
 

1. Single-click the arrow in the Show Page section and select Scan <.   (Chapter 4, Page 
Controls, Show Page) 

2. Single-click on the arrows in the speed section to indicate 6. 

Clearing the page 
 

1. Single-click the arrow in the Clear Previous section and select Scan <. (Chapter 4, Page 
Controls, Clear Previous) 

Simulating the display 
2. Single-click the arrow in the Simulate command on the menu bar.  A display 

simulation window opens and shows the message program you created as it would on 
the actual display. 
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ML Poster for Windows 9

Chapter 

4 
Program Construction  
Your 700 Series message display board operates using the display instructions that you create and 
send to it. A message program contains the display instructions and is kept as a computer file. 
These instructions consist of commands that the Processor in your display translates and displays. 

The ML Poster screen window consists of the following parts: 

� Title Bar � Menu Bar 

� Tool Bar � Page Controls 

� Page Editing Area � Status Bar 

 

                     

           Title Bar →
          Menu Bar→

 Tool Bar→

Page Control→
 
 
 
 
 
 

Page Editing
Area→

 
 
 
 
 
 
 
 
 
 
 

Status Bar→
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ML Poster is Windows-based and therefore contains many standard Windows features.  

 The Title Bar 

 
 

At the top of the screen, ML Poster will display its name and the name of the message 
program that is currently open. 

 

 The Menu Bar 

 
 
The Menu Bar contains the names of the command menus available in ML Poster. Select a menu 
either by clicking on the menu name or by pressing the Alt key and the character that is 
underlined in the Menu Bar. When the menu opens, you can type the underlined letter of the 
option or single-click to select an option. 

File Menu 

 

The File Menu has the functions for working with programs—opening 
and closing existing ones, creating new ones, and saving them, and at the 
conclusion of the task, exiting the ML Poster. 

 
New 

Use the New function to create a new message program.  

1. Start a new message program using one of the following methods: 

� Single-click on File in the Menu Bar and single-click on New 

� Press Ctrl-N (keyboard equivalent) 

� Single-click on the New button  in the Tool Bar 

If you have a message program that has not been saved, ML Poster will ask you if you 
want to save it. After you have saved or not saved, the following dialogue box 
appears: 
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2. Determine the columns (characters per line) and rows (number of lines) of your 
message display board. The maximum number of columns is 6400 and the 
maximum number of rows actually depends on the number of columns you have 
selected. It is important to set the number of columns before setting the rows. 
The maximum number of rows is approximately equal to 6400 (the number of 
possible characters of a page) divided by the number of columns chosen. 

 
3. Use one of the following steps to enter the number of columns: 

� Use the arrows to find the number of columns of your message display 
board  

� Type in the correct number of columns of your message display board  

� Leave the number of columns as is, if it’s correct 

4. Use one of the following steps to enter the number of rows: 

� Use the arrows to find the number of rows of your message display board  

� Type in the correct number of rows of your message display board  

� Leave the number as is, if it’s correct 

For most of the display board, select the Single for the Processor Type.  For large 
display boards of more than 200 characters, select Multiple for the Processor Type. 

5. Single-click the OK button with the mouse or press enter. 

Open 
 
Use the Open function to open an existing message program. 

1. Open using one of the following methods: 

� Single-click on File in the Menu Bar and single-click on Open 

� Press Ctrl-O (keyboard equivalent) 

ML Poster for Windows 11
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� Single-click on the Open button  in the Tool Bar 

2. Use your mouse to find the drive and directory where your program is saved. 

3. Select an existing message program and do one of the following: 

� Double-click on it  

� Press enter  

� Single-click on the OK button 

 
Save 
 

Use the Save function to save the set of pages that is currently open.  

1. Save a set of pages using one of the following methods: 

� Single-click on File in the Menu Bar and single-click on Save 

� Press Ctrl-S (keyboard equivalent) 

� Single-click on the Save button in the Tool Bar 

If this message program has been saved before, ML Poster will save your program in 
the same place using the same name. 

If this program has not been saved before, the word Save will be gray and you must 
select Save As. Refer to Save As following this section. 

 

If you accidentally save over an existing file, you can recover it. ML Poster 
creates a backup copy of every .MSL file you save. The backup has the same 
name as the original file with .BAK extension instead of .MSL extension. To 
retrieve the old file, single-click on File in the Menu Bar and single-click on 
Open. Using the drop down menu in the List of File Types, select (*.BAK). 
Choose the .BAK file of the accidentally saved .MSL file. Single-click the OK 
button 

. 
Save As 

Use the Save As function to save an existing set of pages under a different name or under 
the same name in a different location. 

 
1. Single-click on File in the Menu Bar and single-click on Save As. 

� If this program has not been saved before, use your mouse to find the drive 
and directory where you want to save this program. Type in a name for it. You 
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don’t have to add the .MSL to your message program name—the software does 
it for you. 

� If this program has been saved before and you want to save it in another 
location, use your mouse to find a new drive and directory where you want to 
save this message program. 

� If this program has been saved before and you want to save it with a different 
name, use your mouse to find the drive and directory where you saved this 
program before, and Type in a new name for it. You don’t have to add the .MSL 
to your program name—the software does it for you. 

2. Press enter. 

If you used the same name and the same location, the software will ask you if you 
want to replace the existing file.  

� If you want to save it with the same name, select “Yes”. 

� If you don’t want to save it with the same name, select “No”. 

� Type a new name and press enter. 

About 
 

Use the About function to determine the ML Poster version and system information. 

 
  
Exit 
 

Use the Exit function to quit.  

1. Single-click on File in the Menu Bar. 

2. Single-click on Exit. 

If you haven’t saved the current message program, ML Poster will prompt you to 
save it. Refer to Save and Save As earlier in this chapter. 
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Edit Menu 
The Edit Menu has the functions for working within the pages—cutting, copying and pasting 
text, inserting and deleting pages, inserting the date/time, activating the color dialogue box, text 
justification and single line text mode. The Edit Menu can also be activated, when the cursor is in 
the Page Editing Area, by clicking the right mouse button. 

Undo 
Use Undo to reverse the last action performed.  

1. Choose one of the following methods: 

� Single-click on Edit in the Menu Bar and single-click on Undo 

� Press Ctrl-Z (keyboard equivalent) 

2. Single-click on the Undo button in the Editing Buttons 

Cut 
Use Cut to remove a character, a line or a group of characters or lines from an existing 
page that you want to move to another location on that same page, on another page in 
the set or remove entirely. 

 

When you use the Cut function, the character(s) or line(s) you remove will still 
be available to you on your computer’s clipboard until you Cut or Copy again. If 
the backspace key on the keyboard is used to remove the characters or lines, 
they will not be available on the clipboard for later use. 

 
 

1. To cut, select the character, group of characters, line or lines, you want to cut by 
clicking on them using one of the following methods: 

� If choosing to cut a single character, highlight that character 

� If choosing to cut multiple characters or lines, highlight those characters or 
lines by holding the mouse button and dragging it until you have chosen them 
all.. 

2. Do one of the following: 

� Single-click on Edit in the Menu Bar and single-click on Cut 

� Press Ctrl-X (keyboard equivalent) 

� Single-click on the Cut button in the Editing Buttons 

Grandwell Industries, Inc. 14
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Copy 
Use Copy to copy a character, a line or a group of characters or lines on an existing page 
that you want to have at another location on that same page, or on another page in the 
set. 

 

When you use the Copy function, the character(s) or line(s) lines you remove will still be 
available to you on your computer’s Clipboard until you Cut or Copy again. 

 

1. To copy, Select the character, line or group of characters or lines you want to 
copy by clicking on them using one of the following methods: 

� If choosing to copy a single character, highlight that character 

� If choosing to copy multiple characters or lines, highlight those characters 
or lines by holding the mouse button and dragging it until you have chosen 
them all  

2. Do one of the following: 

� Single-click on Edit in the Menu Bar and single-click on Copy 

� Press Ctrl-C (keyboard equivalent) 

� Single-click on the  Copy button in the Editing Buttons 

Paste 
Use Paste to place the character, line or group of characters or lines you selected with the 
Cut or Copy function. 

1. To paste a cut or copied character, line or group of characters or lines, select the 
position where you want to paste them. 

2. Do one of the following: 

� Single-click on Edit in the Menu Bar and single-click on Paste 

� Press Shift-Insert (keyboard equivalent) 

� Press Ctrl-V (keyboard equivalent) 

� Single-click on the  Paste button in the Editing Buttons 

ML Poster pastes the character(s) or line(s) where you selected. 

Delete Page 
Use Delete Page to remove the current page permanently. 
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1. To delete a page, use the Page Control arrows to specify which page you want to 
remove. 

2. Single-click on Edit in the Menu Bar and single-click on Delete Page. 

ML Poster deletes the page and shifts the subsequent pages. 

Insert Page  
Use Insert Page to insert a page before the current page. 

1. To insert a page, use the Page Control arrows to specify where you want to 
place the new page in the open set of pages. The Insert Page function places the 
page before the current page shown in the Page Control. 

2. Single-click on Edit in the Menu Bar and single-click on Insert Page. 

ML Poster inserts a page and shifts the subsequent pages. 

Insert 
Use Insert to choose the format of date/time you want to include on your page. 

 

 
 

1. Single-click the position on the page editing area you want to insert the 
date/time.  

2. Select Insert under the File menu, then the specific format you want to insert. 

ML Poster inserts the select format string at the insertion point. 

 

 

If the space from the cursor to the end of the line in the Page Editing Area is not 
enough to show the date or time selected, an error will occur. 
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Color 

 

Use Color to activate the text color dialogue box for selecting text color, 
background color and the text flash mode. The colors you select 
become the currently active colors and flash state. Text that is to flash is 
displayed in bold. The top row of colors indicates the text color, while 
the bottom row of colors indicate the background color. 

1. Single-click on Edit in the Menu Bar and single-click on Color.  

2. Highlight the text to change. 

3. Choose the colors you want for text and background. The area on the left side 
of the dialogue displays an example of what you choose. 

4. Single-click on Flash if the text is to appear flashing on the message display 
board. 

Center Justify 
Use Center Justify to align the text in the center of the Page Editing Area. 

1. Single-click in the Page Editing Area before or after typing.  

2. Single-click on Edit in the Menu Bar and single-click on Center Justify. If 
Center Justify is checked but your text is not center justified, you may need to 
deselect it, then reselect it, or press the space bar or the backspace key. 

If Center Justify is chosen before typing, all text will be center justified on every line until 
justification is changed. 

Left Justify 
Use Left Justify to align the text on the left side of the Page Editing Area. 

1. Single-click in the Page Creation Area before or after typing.  

2. Single-click on Edit in the Menu Bar and single-click on Left Justify. If Left 
Justify is checked but your text is not left justified, you may need to deselect it, 
then reselect it, or press the space bar or the backspace key. 

If Left Justify is chosen before typing, all text will be left justified on every line until 
justification is changed. 

Right Justify 
Use Right Justify to align the text on the right side of the Page Editing Area. 

1. Single-click in the Page Editing Area before or after typing.  
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2. Single-click on Edit in the Menu Bar and single-click on Right Justify. If 
Right Justify is checked but your text is not right justified, you may need to 
deselect it, then reselect it, or press the space bar or the backspace key. 

If Right Justify is chosen before typing, all text will be right justified on every line until 
justification is changed. 

Single Line Text (available only on single processor type) 
To use this function follow the directions below. 

1. Under the EDIT display box single-click on Display Size. 

2. To make changes in column size simply click on the small arrows to the right 
of the column box 

3. To adjust the size of a Row simply click on the small arrow to the right of the 
Row box (for a larger window click on the ⇑ arrow and for a smaller window 
click on the ⇓ until you reach the desirable window size) 

Send Menu 

 

This menu command has several functions that communicate with 
the displays or associated with the communication commands. 

 
Date/Time 

This command sets or synchronizes the display’s internal clock with the PC’s clock.  Be 
sure that the PC’s clock is correct before this set date and time command is used. 

When the command is activated the Connection List window is opened.  The list will be 
empty if this is the first time you use the ML Poster to communicate with the display. Go 
directly to step if the connection list is already available. 

1. Click the Edit button in this window to enter the necessary parameters to the list. 
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Location: Enter a descriptive field to make the entry most 
understandable for you. 

Access Number: Enter a phone number if the item is for a modem, 
or IP number if the item is for LAN. 

Type: 

 

Single-click on the dialogue box to edit you type 
of connection.  You will single-click on the type 
of connection you are using such as Serial Port, 
Modem, or TCP/IT 

ID (s): 

 

� Double-click on this field to open the ID 
List dialogue box.  Select the ID number of 
the display you wish to connect. 

� Single-click on a single item for a specific 
display ID, or you may select a range of 
ID’s to be connected.  

Port: Double-click on the Port dialogue box; this will 
give you a drop down list to choose the type of port 
you wish to use.  Standard port number is 3001. 

Speed: Double-click on this box to show the different 
speeds to choose for the serial connection for the 
Display. Standard rate is 9600 baud. 

 

2. Click on Select mode button to finish the editing of the connection and return to 
selection mode. 

3. Click on the line of the connection type you are using to highlight the line, or you 
may select multiple lines by using the standard Windows CTRL and SHIFT with 
mouse click combinations to select multiple connections. 

4. Click OK to start the sending. 

 

Using the connection list can access multiple displays. You may use the standard 
Windows techniques of Ctrl, Shift key combinations for desired combination of 
selections. 
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A Results window will open and show the progress of each communication with the 
displays. If every result returns back from each display is OK then the command is 
completed successfully. 

 

Program 
This command is used to send currently opened message program to the display(s).  If 
the editing window is empty this menu command will be dimmed to indicate that there is 
nothing to send. If the command is available, clicking on this command will open the 
Connection List window identical to the one shown in the Date Time section. The rest of 
the procedure is the same as the Date Time command. 

The message program sent from this command is kept in the display’s default program 
segment.  The default program is a background program having lowest priority in terms 
of scheduling priority. The default message (lowest priority) will be displayed only when 
no scheduled messages (higher priority) at the current time is to be displayed. 

Working Time 
Use the Set Working Time function to set the time the message programs are to run each 
day on the message display board. It uses the 24-hour clock to set the hours and minutes. 
The hours after 12 noon continue counting to 24 (military time). 

 

1. Single-click on the Send in the Menu Bar and single-click on the Set Working 
Time. 

2. Use the arrows in the From and To boxes to set the working time of your 
message display board. 
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Schedule 
This command is used to create or open an existing schedule table.  Click on the 
command to open the Schedule window. 

 
 

There are two menu commands, File and Send, on the Schedule window menu bar. 

F I L E  M E N U  

Open: Use Open to bring a previously saved schedule table 
into the schedule window. 

Save: Use Save to save the current schedule table windows to 
the file. 

 Save As: Use Save As to save the current schedule table window 
as a new file. 

 Close Use Close to close the current schedule table window 
and exit the schedule program. 

 
The techniques of using the file related commands are the same as those described in 
earlier sections. 

S E N D  M E N U  

Schedule: Use Schedule to send the current schedule table 
to the display. 

 Clear: Use Clear to send a clear command to discard the 
display’s schedule table. 

 The techniques of using the Send commands are the same as 
those described in earlier in the Program Editor section. 
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The schedule table lets you specify in each line (a time slot) the time period (From and 
To), date period (Start Date and Stop Date), Day-of-the week, and Message Program List.  
The programs specified in the schedule table in the display has precedence over the 
Default Message Program sent from the Program Editor window (described earlier). 

From: Use “From” to specify the time period to begin running the set of files in 
the display list.  It uses the 24-Hour clock to set the hours and minutes. 
The hours after 12 noon continue counting to 24 which is known to 
most as counting in Military time. 

1. Double-click on the From box on line 1 of the schedule 
dialogue box. 

2. Type in the time to begin running the display list or use the 
arrows at the right of the box to scroll to the selected time. 

3. Press Enter. 

To: Use “To” to specify the time period to end running the set of files in the 
display list.  It also uses a 24-Hour clock to set the hours and minutes. 

1. Double-click on the TO box on line 1 of the Schedule 
dialogue box. 

2. Type in the time to end your display message or use the 
arrows at the right to scroll to the desired end time for the 
message.  

3. Press Enter. 

Start Date: Use the “Start Date” to indicate the day to begin running the files in the 
display list. 

1. Single-click on the Start Date box in line 1 of the Schedule 
dialogue box 

2. Type in the date to begin running the display list.  Use the 
date format of MM/DD/YYYY. 

Or, 

1. Single-click on the Start Date box in line 1 of the Schedule 
box. 

2. Double-click on the Start Date box.  A calendar box will 
appear. 
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3. Click a date box in the calendar to select the date. 

4. Click OK or press Enter to finish it. 

Stop Date: Use the “Stop Date” to indicate the day to end running the files in the 
display list. 

1. Single click on the Stop Date box on line 1 of the Schedule 
dialogue box. 

2. Type in the date to stop running the display list.  Use the 
date format of MM/DD/YYYY. 

Or, 

1. Single-click o the Stop Date box on line 1 of the Schedule 
box 

2. Double-click on the Stop Date box. A calendar box will 
appear. 

 

3. Click a date box in the calendar to select the date. 

4. Click OK or press Enter to finish it. 

S-M-T-W-T-Fr-S: 
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 Use this field to select all or only some days of the week in between the 
Start and Stop dates the program(s) are to be used. Click on the 
corresponding boxes to select the days. 

Program List: 

 The Program List indicates which files in the Program List will run on 
the specified day and time. 

1. Single-click on the Program List box on line 1 of the 
Schedule box. 

2. Single-click on the right mouse button to display the 
following dialogue box. 

 

3. Single-click on the line 1 of the program box. 

4. Single-click on the right mouse button to display the 
Program Selector dialogue box. 

5. Scroll to find the file to add to the Program List. 

6. Select the file. 

7. Single-click OK or press Enter. 

8. Continue adding files to your Program List.  The Program 
List can contain a maximum of 255 files. 

9. Once the list is made, single-click on the boxes beside each 
number to indicate which specific files in the list should be 
displayed.  Up to 12 programs can be selected for each time 
line of the schedule and up to 128 time lines can be 
specified. 

10. Single-click on the File in the Menu Bar and single-click 
on Save-As. 
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11. Scroll to find the location to Save your file. 

12. Name the file and single-click OK or press Enter. 

13. Close the Program List dialogue box.  The Program 
numbers chosen in the Program List dialogue box will 
appear in the Program List. 

14. Continue to add more lines into the schedule table as 
desired. 

15. Single-click the Send menu command on the Schedule’s 
menu bar and move down to Schedule and click the 
mouse.  

16. The Connection List window opens for you to select the 
connection type (s) desired.  Click Ok to send the schedule 
table to the display. 

 

 

Under File in the Menu Bar of the Program List, use Open to open an existing 
Program List that has been edited, or use Close to close an opened Program 
List. 

Edit Connections 
This is used to create or modify the Connection List. Click on the command to open the 
Connection List for editing. The content section of this window is identical to the one 
described in the previous section. When you are done with the editing, click OK to close 
the Connection List window and return to the main window. 

 

Clear Default Program 
This command is used to clear the default program segment memory content. The 
default program segment is loaded when a message program is sent from within the 
program editor window’s “Send/Program” command. 
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The message program in the default program segment is shown only when there is no 
other message programs are specified to show in the Schedule Table. In other words, the 
default program has the lowest priority in the display-scheduling scheme. 

To clear the default program segment: 

1. Single Click on menu command Send and then Clear Default Program. The 
connection window opens. 

2. Click on the line you are using for the connection to the display and Ok or 
Cancel to abort. 

3. The communication result window will open to show the progress of the 
communication with the display if you choose to proceed. 

When the command is completed successfully the display will be blank if no message 
programs are scheduled for display at this time, or become blank when the time is not in 
the time slots specified in the schedule table. 

Display Reset 
This command is used to do a soft reset of the display board. It clears all the programs 
and schedule table in display and the display will show a flashing waiting message 
meaning it’s ready to accept new programs and schedule table. A warning message 
dialogue box shows up to confirm the action. 

 

 If you click YES the display will then be reset. The Connection List window will be 
opened to start the communication process.  The procedures described in the previous 
apply here too. 

Adjust Brightness 
This command is used control the display board brightness level if the display board 
brightness option is enabled. Typically, all indoor products are not available with 
brightness control and outdoor products are available with brightness adjustment using 
manual or auto sensor control 

To change the brightness control mode and level: 

1. Single Click on menu command Send and then Adjust Brightness.  The 
Brightness Control window opens. 
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2. Click on the control mode for Automatic and Ok, or Manual with Hold til 
Reset or Permanent and in the Level box enter the desired level from 0 to 7 (7 
being the top brightness level). Note: Hold til Reset only sets the control until 
the display is turned off 

The brightness of the display should be set to match with the ambient light condition.  
When the ambient is bright the display should be set to bright and vise versa. 

3. Click on Ok to send the settings to the display. The processes of communicating with 
the display are the same as other Send commands described above. 

The result window will open to show the progress of the communication with 
the display. 

Advanced controls of the command are available by clicking on the Advanced 
button (Do not attempt this unless you are really sure you want to do this.). 

The dialogue box window expands to show the Advanced control section. 

Important: Before proceeding, hand copy down all the existing settings in the 
dialogue box. These are the data used in the last operation. 

In the advanced section, there are commands to: 

• Read Table Read the brightness control parameters table from the display 

• Read Sensor Read the current light sensor from the display 

• Read All Read table and sensor level from the display 

• Send Table Send the brightness control parameters table to the display 

• Send Level Send the control mode and level to display 

• Load Defaults Load the brightness control parameters table with default 
values 
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The light sensor is a reading of the current ambient light condition.  The values 
range from 0 to 255; 0 is very bright and 255 is dark.  The parameters table has 8 
boxes, from 0 to 7 representing each control level.  The entry in each box is the 
corresponding light sensor level. 

Under automatic brightness control, if the sensor reads value at or below a 
control level setting, the display brightness will be set to this level.  Under normal 
ambient condition when the light level changes gradually the display’s brightness 
level will also adjust one step at a time to match the ambient light changes. 

Simulate Menu 

 

This command is used to simulate the display message on 
the user’s PC screen.  The first click of this command will 
bring up a simulation window.  In the content screen a 
flashing waiting message simulating a newly powered on 
display with no program(s) in the memory. 
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The current program in the editing window will be sent to the display simulator to simulate the 
message program in action if the page editing area is not empty.  You can leave the simulation 
window open or close it when you are done with the simulation when you need to get back to 
edit or create more display programs. 

Capture Menu 
This command is used to direct the data to a computer instead of sending to the displays.  This 
function is used only if the data is to be transmitted to the displays by other communication 
means other than ML Poster.  The click of this command brings up an Open File window.  Enter 
the file name you would like to use for the captured data and click OK to start. 

 

 The Tool Bar 

 

The Tool Bar is a row of buttons with pictures (or icons) on them. You can perform the 
functions that these buttons represent by simply clicking on them with your mouse—without 
having to pull down a menu. All the buttons in the Tool Bar perform ML Poster functions that 
are discussed in earlier sections of this chapter. 

 Page Controls 
The Page Controls are functions that work with each individual page in the file. It determines the 
page you are currently working on, how the page is displayed and cleared, the speed at which the 
page is displayed and the duration the page is displayed. 

 

Page 
Page indicates which page in the file you are currently working on. When a file is opened 
for the first time. Page 0 will be shown blank. After a page is entered, you can advance to 
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the next blank page. The maximum number of pages in a single file is 256. 

Change the pages using one of the following methods: 

� Single-click the arrows to the right of the page number to scroll through the 
pages in the file.  

� Highlight the number in the box then type the page number you want to move 
to. 

� With the cursor in the page number box or the page creation area, press the page 
up key to move backward or the page down key to move forward. 

Remark 
Use the Remark area to type any notes to yourself or another user for each page in a file. 
These notes could be general information about the contents or instructions. The 
maximum length of a Remark is 59 characters. 

Show Page 
Use Show Page function to indicate how the page will be displayed on the message 
display board. The following list explains each choice:  

At Once  Each character will display instantly 

Scan  Each character will scan on from left to right 

Scan  Each character will scan on from right to left 

Scan  Each character will scan on from top to bottom 

Scan  Each character will scan on from bottom to top 

Push  Each character will push on from left to right 

Push  Each character will push on from right to left 

Push  Each character will push on from left to right 

Push  Each character will push on from bottom to top 

Flow  Each character will flow from top to bottom building 
from the bottom pixel by pixel 

Single-click on the arrow to the right and scroll to choose the Show Page function you 
want. 

Speed 
Use Speed to indicate how fast the Show Page function will display your page on your 
message display board. The Speed ranges from 0 (slow) to 9 (fast). 
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Change the Speed using one of the following methods: 

� Single-click the arrows to the right of the Speed to scroll from 0 to 9. 

� Highlight the number in the box then type the Speed you want from 0 to 9. 

Duration 
Use Duration to indicate how long the page will display on your message display board. 
The Duration ranges from 0 to 32 seconds. 

Change the Duration using one of the following methods: 

� Single-click the arrows to the right of the Duration to scroll from 0 to 32.  

� Highlight the number in the box then type the Duration you want from 0 to 32. 

Clear Previous 
Use Clear Previous function to indicate how the previous page will be erased from the 
message display board before showing the page that your are currently working on in the 
page creation area. The following list explains each choice:  

No  Contents will not be erased and the new page will appear 
where there are text changes 

Cover  Contents of the new page will completely cover the 
previous page 

At Once  Each character will display instantly 

Scan  Each character will scan on from left to right 

Scan  Each character will scan on from right to left 

Scan  Each character will scan on from top to bottom 

Scan  Each character will scan on from bottom to top 

Push  Each character will push on from left to right 

Push  Each character will push on from right to left 

Push  Each character will push on from left to right 

Push  Each character will push on from bottom to top 

Flow  Each character will flow from top to bottom building 
from the bottom pixel by pixel 

Single-click on the arrow to the right and scroll to choose the Clear Previous function 
you want. 
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 Page Editing Area 
The Page Editing Area is where you create each page, as it will appear on your message display 
board. You can single-click anywhere within the Page Creation Area and type. When typing, 
remember that clicking the right mouse button displays the Edit menu. 

The Insert key on your keyboard can also be activated in the Page Creation Area. Toggling the 
Insert key changes the typing to insert or overwrite characters on the line. The typing mode is 
indicated by the word “OVER” in the right-hand corner of the Status Bar. OVER will be black if 
typing is in the overwrite mode, gray if in the insert mode. 

 

 
 

 Status Bar 

 

The line at the bottom of the software screen contains information about your ML Poster 
software. That information is: 

� The status message 

� OVER- shows whether text is in the insert or overwrite mode 

� The size, in characters (columns x rows), of your message display board 
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